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Mike Fechner, Consultingwerk Ltd. 

 Independent IT consulting organization 

 Focusing on OpenEdge and .NET 

 Located in Cologne, Germany 

 Customers in Germany, EMEA, USA 

 Vendor of tools and consulting programs 

(specialized on GUI for .NET, Modernization) 

 23 years of Progress experience (V5 … V11.2) 

 Passionate OpenEdge Architect user since 

10.1A 

 But I’m not a Java programmer… 
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 WinKit 

 SmartComponent Library 

 Dynamics4.NET 
 

 Tools can be used together or separately 

 Shared common code base 
 

 SmartComponents.Mobile 

 SmartComponents.Web 

 SmartBPMAdapter for OpenEdge BPM/Savvion 
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OpenEdge® application modernization solutions 
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Agenda 

 A (short) Review of OpenEdge Architect 

 (Personal) Preferences in OpenEdge Architect 

 OpenEdge Editor Macros 

 Setting the Author Name used by Templates 

 Progress Customization Options 

 JET Templates 

 Installing Plugins for JET in OEA/PDSOE 

 Customizing OpenEdge Architect Templates 

 



OpenEdge Architect 

 Eclipse based, extensible  

 Available since 10.1A (continuously enhanced 

since then) 

 Alternative to the AppBuilder / OpenEdge Studio 

 Requires a separate license (included in PSDN 

SDK), parallel installation possible 

 AppBuilder, ADM1/2 and Dynamics integrated 

 Extensible using 3rd party plug-ins (commercial 

or community based) 

 Windows only 
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Reasons to migrate to OpenEdge Architect 

 GUI for .NET 

– Visual Designer, Class Browser 

 object-oriented coding 

– no class template in AppBuilder, class browser 

 AppServer Development (10.2B, 11.x) 

 OE Mobile 

 REST Adapter 

 OpenEdge BPM 
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Agenda 

 A (short) Review of OpenEdge Architect 

 (Personal) Preferences in OpenEdge Architect 

 OpenEdge Editor Macros 

 Setting the Author Name used by Templates 

 Progress Customization Options 

 JET Templates 

 Installing Plugins for JET in OEA/PDSOE 

 Customizing OpenEdge Architect Templates 

 

 

 



Workspace preferences in OEA 

 Main menu-bar, Window -> Preferences 
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Workspace preferences in OEA 

 General – Editors – Text Editors 

– Insert spaces for Tabs, Tab width, show line 

numbers, … 

 General – Search  

– Reuse editors … turned off 

 OpenEdge Architect – Editor 

– As you type: Case (upper or lower), case 

keywords, depending on your style: expand 

keywords 
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Workspace preferences in OEA 

 General – Workspace 

– Refresh automatically (on fast machines, local 

source code) 

 Refreshing causes Eclipse to permanently search 

the file system for new, deleted, modified files 

 Sync‘s Eclipses view of the world to the file system 

 May cause recompile 

 Files not in sync will be skipped on compile, search, 

etc…  

 Alternative is manual refresh (e.g. F5 key) 
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Workspace preferences in OEA 

 OpenEdge Architect – Editor – Build 

– Auto check syntax  (while typing) 

– Maximum number of errors reported per build: 

much higher than 100 (e.g. 100,000) when 

you have 

• templates or scratch files 

• migration routines that typically never 

compile 

• just never cleaned up source code (Copy of 

test.p, test_backup.p) 
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Link with Editor (Resource view) 

 Keeps resource view  

(file browser) and current 

editor in sync when  

switching editor tabs 

OpenEdge Architect Template Customization 12 



Error filters 

 Use error filters dialog to configure filters 

– default (show all) usually not helpful on large 

projects 

– my preference is ‘selected element and its 

children‘ 

– or use working sets  
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Agenda 

 A (short) Review of OpenEdge Architect 
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 JET Templates 

 Installing Plugins for JET in OEA/PDSOE 

 Customizing OpenEdge Architect Templates 

 

 

 



OpenEdge Editor Macros 

 Defined in the Workspace Preferences 

 Progress OpenEdge  Editor  Templates 

(Macros) 

 Macros can be inserted automatically when you 

type the name followed by the space key 

 Macros may also require the content assist 

dialog (CTRL-SPACE) 
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OpenEdge Editor Macros 

 Progress preinstalls a set of Macros 

 DVCH: DEFINE VARIABLE     AS CHARACTER 

 MES: MESSAGE    VIEW-AS ALERT-BOX 

 &FR    {&FRAME-NAME} 

 …  

 

 MES Macro requires some polishing… 
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OpenEdge Editor Macros 

 Macros may contain variables that will be replaced 

when inserted to the editor 

 ${cursor} defines where the cursor should remain 
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Macro variables 
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Custom Variable 



Exporting and Importing Macros 

 Macros are stored in the workspace metadata 

 Exporting and importing allows reusing in 

different workspaces and sharing with other 

people 

 Import and Export Buttons in the Macro Dialog 
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Agenda 

 A (short) Review of OpenEdge Architect 

 (Personal) Preferences in OpenEdge Architect 

 OpenEdge Editor Macros 

 Setting the Author Name used by Templates 

 Progress Customization Options 

 JET Templates 

 Installing Plugins for JET in OEA/PDSOE 

 Customizing OpenEdge Architect Templates 

 

 

 



Setting the Author name for Templates 

 Some of the Templates and Wizards use the 

windows login name as the Author reference 

– Mike 

– mikefe 

– fec878 

– Administrator 

– Progress 
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Setting the Author name for Templates 

 Use vmargs –Duser.name Startup parameter 

to override this 
 http://blog.consultingwerk.de/consultingwerkblog/2011/08/customizi

ng-openedge-architect-templates-made-easy-personalization/ 

C:\Progress\OpenEdge102B\oeide\eclips

e\eclipse.exe -showlocation -vm 

“C:\Progress\OpenEdge102B\jre\bin\jav

aw.exe” -vmargs -Duser.name=”Mike 

Fechner / Consultingwerk Ltd.” 
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Setting the Author name for Templates 
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 JET Templates 
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Progress Customization Editor 

 In the OpenEdge Editor Perspective 

 OpenEdge -> Tools -> Customization Editor 
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Progress Customization Editor 

 ProTools for PDSOE: 

– Menu / Toolbar Entries, Editor Context Menu 

 Template Overrides 

 Custom Project Templates  

 

 

 Modifications require to “Refresh 

Customization Options” 

 When prompted for resetting the perspective, 

choose no! 
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Opening files form ABL code 

 Useful for Menu / Toolbar Entries and Editor 

Context Menu 

 Public API‘s defined in  

adecomm/oeideservice.i 

 Supports querying basic project properties, 

opening views for ABL windows (like OEUnit 

does) and opening files  

 getProjectName () 

 openEditor () 
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Sample Open Debug Listing 
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Sample Open Debug Listing 
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Function prototype defined 

in oeideservice.i 



ABL Scratchpad 

 There is finally an ABL  scratch pad in 11.2 

 But it’s a view, not an Editor – so here’s my 

workaround that also works on 10.2B 

 Basically creates a copy of an empty file 

 

 Could also create a (dynamic) copy of a file with 

content 
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ABL Scratchpad 
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JET Templates 

 Java Emitter Templates 

 Dynamic Template format 

 Text files that are converted into Java source 

 Compiled Java classes executed when you 

create a new file or new block of code 

 http://www.eclipse.org/articles/Article-

JET/jet_tutorial1.html 

 http://www.eclipse.org/articles/Article-

JET2/jet_tutorial2.html 
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JET Templates 

 Anyone remembers SpeedScript (Web Speed)? 

 It’s similar (html + 4GL  pure 4GL  R-Code) 

 

 Templates based on a skeleton file 

– Java file that contains header of generated 

Java class 

 Typically contains import statements (Java 

version of USING statement) 
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JET Template 

 Text file 

 Contains header 

OpenEdge Architect Template Customization 37 



JET Escape sequences 

 Escape sequence for a single Java expression 

(value) 

 

 

 Escape sequence for a block of Java statements 

 

 

 

 Can be nested, just like normal Java code 
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<%= data.getClassName() %> 

 <% 

 for (Iterator iter = fields.iterator(); iter.hasNext();)  

 { Field field = (Field)  

  iter.next();%><%=OETemplateUtil.generateField(field, NL)%> 



JET Templates 

 Jet Templates are executed with an input 

parameter 

 That‘s the input from the Wizard that executes 

them 

 Data in input parameter dependent on the type 

of template (class, interface, method, etc.) 
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Template generation sequence 

 Sequence executed whenever 

source file is modified 
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JET Template + 

generator.skeleton 

(Java source code) 

Java Source code 

.java file 

Compiled Java 

Class file 

.class file  

Register in 

Customization 

Editor 
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Setting up JET for OpenEdge 

 http://communities.progress.com/pcom/docs/DO

C-16387 

 Documentation a bit outdated (10.1B) 

 Works with 10.2B with a little tweaking and 

creativity  

 Trivial to use on 11.2 

 Use existing templates as a starting point, create 

copies of files in DLC\oeide\eclipse\plugins\ 

com.openedge.pdt.text_version\templates 
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Required Plugins 

 Writing custom JET Templates requires the 

following Eclipse Plugins/Frameworks: 

– JDT – Java Development Tools 

– EMF – Eclipse Modeling Framework 

 Use version appropriate for your OpenEdge 

Architect installation … (Eclipse version used) 

 Templates created with OE10.2B work fine in 

newer versions of PDSOE 

 Templates can be used by others without JDT 

and EMF 
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Required plugins 

 Plugins can be installed into OEA/PDSOE using 

Software Updates 

 PDSOE in 11.2 is based on Eclipse Indigo which 

is Eclipse 3.7 

 PDSEO in 11.0, 11.1 is based on Eclipse Helios 

which is Eclipse 3.6 

 OEA in 10.2B is based on Eclipse Ganymede 

which is 3.4 

 JET and EMF preinstalled in 11.2, only need to 

install the JET SDK 
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Eclipse Plugins 

 Eclipse Plugins for my 10.2B installation 
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Setting the Java Build Path 

 Add the following two external JAR files for 

OpenEdge 11.2: 

 

 C:\Progress\DeveloperStudio3.7\eclipse\plugins\c

om.openedge.pdt.core_11.2.1.00\oe_common_

services.jar 

 C:\Progress\DeveloperStudio3.7\eclipse\plugins\c

om.openedge.pdt.text_11.2.1.00\progresside.jar 
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Setting the Java Build Path 

 Java Build Path from white paper needs 

additional .jar file in 10.2B/11.x: progresside.jar 
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Editing .jetproperties 

 In 10.2B with the plugins installed the JET 

properties are part of the project properties 
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Alternatively editing .jetproperties file 

 Text/XML file in project root 

 Change source container setting to: src 

 Restart PDSOE when done 

OpenEdge Architect Template Customization 50 



Alternatively editing .jetproperties file 

 . resources are hidden in the resource view by 

default 

 Resource view  

context menu ->  

Customize View 
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Enable JET for OpenEdge Project 

 File -> New 
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Customizing Templates for OEA/PDSOE 

 OEA/PDSOE templates based on JET 

 Overriding existing templates for new files, e.g. 

modifying the file header comment  

 Overriding existing templates for new code 

blocks, e.g. new internal procedure wizard, new 

method, new property 

 Additional new file templates 

– Currently only supported for .p file extension 

(functional limitation) 
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Customizing Templates for OEA/PDSOE 

 Typically custom templates based on Progress 

supplied templates 

– C:\Progress\DeveloperStudio3.7\eclipse\plugi

ns\com.openedge.pdt.text_11.2.1.00\templa

tes 

– C:\Progress\OpenEdge102B\oeide\eclipse\plu

gins\com.openedge.pdt.text_10.2.1.06\temp

lates 

 Contains also the skeleton file 
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OpenEdge Architect Templates 
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Modifying templates 

 Optionally create custom skeleton file, that 

provides standard includes etc. 

 Set custom class name (template name) in 

<%@ header 

 Set custom package name in the <%@ header 

 

 Start writing template   
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Sample „Enum“ template 

 Based on the class template 

 Generate additional code based on Super-Class 
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Registering your custom templates 
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Demo 

 Template customization environment 

 Customized method template 

 Customized new class template 

 Review Java functions 

 Review code in JET Template that checks for 

class properties 

 Review usage of custom Templates in 

OpenEdge Architect 
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Customization settings 

 Settings are persisted per OEA/PDSOE 

installation, not per workspace 

 No need to re-customize in every workspace! 

 When registering custom templates, they need 

to be made available in every workspace 

– Path to custom templates is set in the 

workspace (see later) 
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Template binary location in Preferences 
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Using templates on other workspaces 

 Just provide the contents of your bin folder 

 I prefer the SCM tool for that  
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More info… 

 Getting started videos 

http://communities.progress.com/pcom/docs/DO

C-101140 

 Top OpenEdge Architect FAQ, Sunil Belgaonkar 

http://communities.progress.com/pcom/communi

ty/psdn/exchange/trackprod6 

 Consultingwerk blog – openedge-architect tag 

http://blog.consultingwerk.de/consultingwerkblog

/tag/openedge-architect/ 
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Questions ? 
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Thank you! 


